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Preface

Mathematical formulas and Greek letters seem to intimidate many people, so
this book focuses on providing clear word descriptions and step-by-step Excel
instructions, rather than including lots of x’s and y’s everywhere. We have specifi-
cally avoided including a lot of technical information. This book was written for
those who want basic understanding of how to use statistics in the business world
without all the details of statistical theory. It is designed to enhance a practical
learning of statistics by nonstatisticians and to make the experience a little easier
and maybe even fun.

This book has also been written with managers in mind who may need a quick
refresher on how to complete Excel analysis without having to wade through pages
of technical explanations. Those more detailed technical explanations can be found
in traditional statistics textbooks. The key concepts in this book are more complex
than the presentations in this book might suggest. We have aimed at concisely
defining the concepts and providing simple descriptions and explanations on how to
use them.

For instructors, this publication is designed as a companion guide to your core
text. Students can practice their skills that have been introduced to them in the
classroom. However, at the beginning of each chapter, the key concepts are
summarized to remind them of what is important with the topic.

We believe that problems and case studies should involve actual data from the
business community. Therefore, there is a continuing analysis throughout several of
the chapters using a real business case from Infinity Auto Insurance. The data sets
for the other practice problems in each chapter have been kept intentionally small so
that the user can more easily maneuver within the data. The rigorous sample size
rules have been put aside to accommodate this design goal. The same Excel
procedures apply to all sizes of data sets, small or large.

This book was written using Excel 2010; the screenshots may appear slightly
different if you are using an older version of Excel or if you are using a Mac. If you
are comfortable in Excel, these differences should be minor.

We have included only those analytic Excel tools that are most commonly used
in the workplace to keep things simple. This approach should work well for those
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having to run their own analysis, as well as for those needing to better understand
statistical reports, so as to make informed business decisions.

No prior Excel experience is necessary, although it may prove helpful.
Instructions are provided with the mindset that this is the first time you have used
this particular Excel functionality. In other words, each chapter provides simple
instructions for first-time users.

Some of the traditional statistical texts include Excel instructions. But these are
typically embedded deep in the chapter as one of several different software instruc-
tion packets. This book focuses only on Excel and provides easy-to-find Excel
instructions in each chapter.

In addition to offering this book in traditional textbook form, it is also available
as an e-book in recognition of being environmentally responsible.

The authors bring a unique perspective as guides through the World of Statistics.
Their combined skills and expertise in the workplace and the classroom equip them
to understand the challenges students and managers face as they navigate the World
of Statistics. Their active consulting and teaching lives keep them up to date on the
common real-world issues in understanding and applying statistical concepts.

We have worked diligently to make sure that this book is accurate and error free.
But if you happen to find any errors or have suggestions for improvements, please
contact us at jfogli@hotmail.com or lherkenh@stmarys-ca.edu.

Many of you have survived statistics courses through pure memorization, but
hopefully this book will encourage both logical reasoning and intuitive understand-
ing. We believe that logical reasoning is fundamental to retaining analytical skills
that can be practiced in the real world. Enjoy. . ..

Orinda, CA, USA Linda Herkenhoff
Pleasant Hill, CA, USA John Fogli


jfogli@hotmail.com
lherkenh@stmarys-ca.edu
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Chapter 1
Data and Statistics

Case Study: Exploring New Marketing Strategies

Auto Insurance

Infinity Property and Casualty Corporation (Infinity Auto Insurance)
headquartered in Birmingham, Alabama provides personal automobile insur-
ance with a concentration on nonstandard auto insurance. Nonstandard
insurance serves individuals unable to obtain coverage through standard
insurance companies, which can be due to a driving record with accidents
and/or tickets, prior DUI, the driver’s age, vehicle type, etc. Infinity Auto
Insurance’s products include personal automobile insurance for individuals,
commercial vehicle insurance for businesses and classic collector insurance for
individuals with classic and antique automobiles. Infinity Auto Insurance
distributes its products primarily through independent agencies and brokers.
Infinity Auto Insurance, a top-performing Infinity brand, provides nonstandard
car insurance through more than 12,500 independent agents. Infinity Auto
Insurance utilizes Internet-based software applications to provide many of its
agents with real-time underwriting, claims and policy information. The Com-
pany is licensed to write insurance in all 50 states and the District of Columbia.
The company traces its roots back to 1955 doing business as Dixie Insurance
company, later known as The Infinity Group. In 1991, Pennsylvania Com-
pany (American Premier Underwriters) purchases The Infinity Group.
American Premier Underwriters, Inc. and the American Financial Corpora-
tion merge and become the American Financial Group (AFG) in 1995.

(continued)

L. Herkenhoff and J. Fogli, Applied Statistics for Business and Management 1
using Microsoft Excel, DOI 10.1007/978-1-4614-8423-3_1,
© Springer Science+Business Media New York 2013
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Case Study: (continued)

The company was officially founded in 2002 when AFG transferred all
common stock of Infinity and its sister companies to IPCC. In 2003, IPCC
was listed on the NASDAQ as a registered public holding.

Food for Thought

Who are some of Infinity Auto Insurance’s direct auto insurance
competitors?

How large (annual revenue) is the Auto Insurance industry?

Discuss what type of customers Infinity Auto Insurance might target?

If you were a marketing consultant to Infinity Auto Insurance, what market
areas would you suggest to target to access the customers identified above?

Possible Answers

Who are some of Infinity Auto Insurance’s direct auto insurance
competitors?
GEICO, Progressive, Mercury, AIG

How large (annual revenue) is the Auto Insurance industry?
Annual revenue for the Auto Insurance industry ranges in billions of dollars
every year.

Discuss what type of customers Infinity Auto Insurance might target?
High risk auto insurance individuals

If you were a marketing consultant to Infinity Auto Insurance, what market
areas would you suggest to target to access the customers identified above?
Large metropolitan areas or lower income areas

Key Concepts

Business statistics, Constant, Continuous data, Cross sectional data, Data,
Descriptive statistics, Discrete data, Distribution, Frequency, Inferential statistics,
Longitudinal data, Population, Probability, Qualitative data, Quantitative data,
Random sample, Sample, Scales, Statistics, and Variables.
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Discussion

This chapter will include some of the basic concepts and definitions necessary in
understanding and applying statistical methods in business. One of the challenges in
statistical analysis and subsequent report writing is the confusion over what words
and statistical terms really mean. In statistics the mathematical meaning may not
match up with the everyday usage of the same term, which can lead to confusion.
For example in our daily communications the term “significant” means important
i.e. Steve’s attendance, as the current CEO, at the award ceremony was very signifi-
cant to the press. In statistics when a statistic is “significant”, it simply means that you
are very sure that the statistic is reliable or real and not just due to chance. It doesn’t
mean the finding is important nor that it has any decision-making utility.

Statistics is often said to be more open to misuse, both deliberately and naively,
than any other area in business. Part of that misuse may stem from inconsistency in
statistical definitions. The next few pages will attempt to firmly establish the
lexicon for moving into the next chapters, but each chapter will also provide content
specific definitions. It is in your best interest to take the time to read thought these
terms and not assume you have a complete and fully accurate understanding of
these key concepts.

Business statistics: Business statistics include the areas of descriptive statistics,
probability statistics, and inferential statistics applied to business.

Constant: A value that remains unchanged. For example let C be a constant,
C = number of years of university education required for all entry level
accountants in your company and in this case C = 4 years.

Cross-sectional data: Cross-sectional data is data that are collected from
participants at one point in time (rule of thumb is usually within six or less months).
Time is not considered one of the study variables in a cross-sectional research design.
In a cross-sectional study, time is assumed to be a random effect that produces only
variance, not bias. For example the number of IPOs in the San Francisco area.

Data: Data is specific values of the variables if interest that are collected, analyzed
and summarized for presentation and interpretation.

Descriptive statistics: The statistics associated with organizing, summarizing and
presenting data in a convenient and informative way. Both graphical and numerical
techniques are employed.

Distribution: an arrangement of values of a variable showing their observed or
theoretical frequency of occurrence.

Frequency: How often a value occurs.

Inferential statistics: The statistics associated with making an estimate, prediction,
or decision from a small group to draw conclusions about a larger group. For
example in a random sample we note that 40 % of the voters do not want an increase
in business taxes. If the sample has been selected without bias, we can infer the
population would also vote about 40 % against an increase in business taxes.
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Longitudinal data or time series data: Data collected over several time periods.
For example the number of IPOs in the San Jose area over the past 5 years. In this
example the time period would be defined as 1 year and we are collecting data over
5 of these time periods, or years. Note the term longitudinal has nothing to do with
geo-spatial data on the globe.

Population: All the existing individuals, items, or data about which you want to
draw a conclusion. For example all of the MBA graduates in the USA, or all the
copy machines owned by your company in the past 5 years.

Probability: The analysis associated with the chance of occurrence of one or more
possible results of an unpredictable event. When potential students apply to an
MBA school, they consider the chance or probability of being accepted.

Qualitative data: Categorical, non-numeric data such as gender, industry type.
There is no mathematical relationship between the data values. The data labels can
be numeric or non-numeric, and are descriptors of the data. For example the labels
may be True/False or could be shown as 1/2. But there is no mathematical
relationship between 1 and 2 in this case, they are just labels. In other words 2 is
not twice as big as 1.

Quantitative data: Numerical data such as salaries, or sales. There is a mathematical
relationship between the data values. The data labels must always be numeric.
However quantitative data can be either discrete or continuous. Continuous quanti-
tative data arise from a measurement process. Continuous data is information that can
be measured on a continuum or scale. Continuous data can have almost any numeric
value and can be meaningfully subdivided into finer and finer increments, depending
upon the precision of the measurement system. For example time may be considered
as continuous quantitative data. Discrete quantitative data arise from a counting
process. An example includes how many text messages you sent this past week.

Random sample: Data selected from a population in a way that ensures each data
value has an equal opportunity of being selected.

Sample: A portion of a population selected for analysis.

Scales (measurement): A scale may be defined as any set of items which is
progressively arranged according to value or magnitude into which an item can
be placed according to its quantification. In other words a scale is a continuous
spectrum or series of categories. The purpose of scaling is to represent, usually
quantitatively, an item’s, a person’s or an event’s place in the spectrum. The four
types of scales are nominal, ordinal, interval and ratio.

* Nominal scale
A scale in which the numbers or letters assigned to objects serve as labels for
identification or classification. An example of this scale includes MBA schools.
* Ordinal scale
A scale that arranges objects or alternatives according to their ranking.
An example includes the Business Week ratings of MBA schools.
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Scale Type Numerical Operations Descriptive Statistics
Nominal Counting Frequency in each category
Percentage in each category
Mode
Ordinal Rank ordering Median
Range
Percentile ranking
Interval Arithmetic operations on Mean
intervals between numbers Standard deviation
Variance
Ratio Arithmetic operations on actual Geometric mean
quantities Coefficient of variation

Fig. 1.1 Descriptive statistics for types of scales

« Interval scale
A scale that not only arranges objects according to their magnitudes, but also
distinguishes this ordered arrangement in units or equal intervals. The interval
between measurements is a meaningful value. It does not involve a true zero
point. Standardized test scores in MBA entrance exams is an example of this
scale.

» Ratio scale
A scale having absolute rather than relative quantities and possessing an absolute
zero, where there is an absence of a given attribute. The number of years an
MBA program has been offered is measured on a ratio scale.

These scales and their associated descriptive statistics are summarized in Fig. 1.1.
All statistics that are appropriate for lower-order scales (nominal is the lowest) are
appropriate for higher-order scales (ratio is the highest) but not vice versa.

Statistics: Values derived from the data collected from a random sample.

Variables: Characteristics of interest that may change, unlike a constant, within the
scope of a given problem. For example the variable s = executive salary, and the
associated values include: s; = $200,000, s, = $580,000, s3 = $610,000.

Common Pitfalls

<& Be careful of longitudinal data. Make sure the conditions for the data collection
process have remained constant. Often environmental factors may change and
thus bias the data.

& You cannot convert qualitative data to quantitative data by changing the labels
to numeric format.

<& Don’t show too many decimal places. You cannot make your answer more
precise than the data that was used to calculate it.

<& Make sure the scales have the correct units of measurement and variable name.
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Final Thoughts and Activities

Practice Problems

1. Longitudinal data: Take a look at what has been happening with world record
times in the men’s mile run since 1900. Extrapolate forward 5 years from today,
by simply continuing the same trend of the existing line. Are you surprised?

2. AVERT is an organization that is dedicated to eradicating AIDS in Africa.
Explore their website and decide if the statistical data is helpful or is there just
too much? Is the data presented in a useful way or is it somewhat misleading?
Pay careful attention to the percentage data.

> Open www.avert.org

> Click on the tab HIV and AIDS Topics

> Click on Statistics

> Click on Africa HIV and AIDS Statistics. You have two different reports to
view on South Africa and Sub-Saharan Africa

Discussion Boards

1. Often political goals can get in the way of accurate reporting of data. Discuss this
and any other issues that might be obstacles in getting complete and accurate
data on the unrest in Afghanistan.

2. This year’s top mutual funds will likely slide in rank next year. Do you agree/
disagree? Use statistical arguments to support your position.

3. Statistics can change your life. . . disagree or agree. Provide detailed examples to
support your position.

4. Why was Moneyball such a popular book and movie?

Group Activity

Productivity Growth, defined as getting more output per hour worked by an
employee, has been identified as a key goal in companies within the United States.
Often companies provide managers and workers with rewards and special
incentives for resulting gains in productivity.

Search the web to find supporting data on one of the positions (pro or con) in
addressing the question: Are productivity gains always in the best interest of
society?


http://www.avert.org/

Problem Solutions

Parting Thought

It has been proven that the celebration of birthdays is healthy. Statistics show that
those people who celebrate the most birthdays are the oldest. . .

Problem Solutions

Problem #1: Longitudinal Data
Answer: (Answers may vary) The world record times have decreased in time since
the 1900s. Runners have gotten faster.

The table of data for this problem was retrieved from Wikipedia on March 7, 2012
(http://en.wikipedia.org/wiki/Mile_run_world_record_progression#cite_note-iaaf-4)

Time Athlete Nationality Date Venue

4:14.4 John Paul Jones United States 31 May 1913 Allston, Mass.
4:12.6  Norman Taber United States 16 July 19155 Allston, Mass.
4:10.4  Paavo Nurmi Finland 23 August 19231 Stockholm
4:09.2 Jules Ladoumegue France 4 October 19315 Paris

4:07.6  Jack Lovelock New Zealand 15 July 19335 Princeton, N.J.
4:06.8 Glenn Cunningham United States 16 June 19345! Princeton, N.J.
4:06.4 Sydney Wooderson  United Kingdom 28 August 1937 Motspur Park
4:06.2  Gunder Higg Sweden 1 July 19420 Géteborg
4:06.2 Arne Andersson Sweden 10 July 19425 Stockholm
4:04.6 Gunder Higg Sweden 4 September 19425 Stockholm
4:02.6 Arne Andersson Sweden 1 July 19431 Goteborg
4:01.6 Arne Andersson Sweden 18 July 1944551 Malmé

4:01.4  Gunder Higg Sweden 17 July 1945 Malmé

3:59.4  Roger Bannister United Kingdom 6 May 1954! Oxford

3:58.0 John Landy Australia 21 June 1954 Turku

3:57.2  Derek Ibbotson United Kingdom 19 July 1957" London
3:54.5  Herb Elliott Australia 6 August 1958 Santry, Dublin
3:54.4 Peter Snell New Zealand 27 January 19621 Wanganui
3:54.1  Peter Snell New Zealand 17 November 1964'>!  Auckland
3:53.6  Michel Jazy France 9 June 1965 Rennes

3:51.3 Jim Ryun United States 17 July 1966 Berkeley, Cal.
3:51.1  Jim Ryun United States 23 June 1967 Bakersfield, Cal.
3:51.0  Filbert Bayi Tanzania 17 May 1975} Kingston
3:49.4 John Walker New Zealand 12 August 1975" Goteborg
3:49.0  Sebastian Coe United Kingdom 17 July 1979 Oslo

3:488  Steve Ovett United Kingdom 1 July 1980" Oslo

3:48.53  Sebastian Coe United Kingdom 19 August 1981 Ziirich
3:48.40  Steve Ovett United Kingdom 26 August 19815 Koblenz
3:47.33  Sebastian Coe United Kingdom 28 August 1981! Bruxelles
3:46.32  Steve Cram United Kingdom 27 July 1985 Oslo

3:44.39 Noureddine Morceli  Algeria 5 September 19935 Rieti

3:43.13 Hicham El Guerrouj  Morocco 7 July 19995 Rome

151 Referenced from “12th IAAF World Championships In Athletics: IAAF Statistics Handbook.
Berlin 2009.” (PDF). Monte Carlo: IAAF Media & Public Relations Department. 2009. pp. Pages
546, 549-50. Retrieved August 4, 2009


http://en.wikipedia.org/wiki/Mile_run_world_record_progression#cite_note-iaaf-4
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Excel Output

Let’s look at how often the record actually changes and by how much it changes.
It seems that the changes as expected are very small. But even so, how fast can
humans actually run. .. there must be some limit. The time between records seems
to almost follow a cycle, where several records get set close together and then it
takes a while for a new break through time. The last time the record was set was in
1999; based on the pattern, it seems that we are long overdue for a new record and
should expect one in the next 5 years, but not by much.

Difference in #years between

Time new record Date records
04:14.4 31 May 1913

04:12.6 00:01.8 16 July 1915 2
04:10.4 00:02.2 23 August 1923 8
04:09.2 00:01.2 4 October 1931 8
04:07.6 00:01.6 15 July 1933 2
04:06.8 00:00.8 16 June 1933 2
04:06.4 00:00.4 28 August 1937 3
04:06.2 00:00.2 1 July 1942 5
04:06.2 00:00.0 10 July 1942 0
04:04.6 00:01.6 4 September 1942 0
04:02.6 00:02.0 1 July 1943 1
04:01.6 00:01.0 18 July 1944 1
04:01.4 00:00.2 17 July 1945 1
03:59.4 00:02.0 6 May 1954 9
03:58.0 00:01.4 21 June 1954 10
03:57.2 00:00.8 19 July 1957 3
03:54.5 00:02.7 6 August 1958 1
03:54.4 00:00.1 27 January 1962 4
03:54.1 00:00.3 17 November 1964 2
03:53.6 00:00.5 9 June 1965 1
03:51.3 00:02.3 17 July 1966 1
03:51.1 00:00.2 23 June 1967 1
03:51.0 00:00.1 17 May 1975 8
03:49.4 00:01.6 12 August 1975 0
03:49.0 00:00.4 17 July 1979 4
03:48.8 00:00.2 1 July 1980 1
03:48.5 00:00.3 19 August 1981 1
03:48.4 00:00.1 26 August 1981 0
03:47.3 00:01.1 28 August 1981 0
03:46.3 00:01.0 27 July 1985 4
03:44.4 00:01.9 5 September 1993 8
03:43.1 00:01.3 7 July 1999 6

Problem #2: AVERT Case Study
Be careful when working with percentages. They can be misleading. It is important
to have the actual sample size associated with the percentage. For example 50 % of



Problem Solutions 9

100 people is 50 people but 50 % of 2 people is only one person. Also be careful that
you are comparing “apples with apples”. This organization tends to compare data
from countries with different populations and demographics. Also comparing
regional data with single country data can be misleading.

The first set of data that is presented in the case study is related to the impact on
the health sector in the countries of sub-Saharan Africa. Consider that 40 % of
midwives in Zambia were found to be HIV positive. This information, coupled with
the decrease in health care workers, may lead you to believe that there is a lack of
education for health care workers in how to care for AIDS patients. Perhaps more
data on what the African government and AVERT are doing to promote education
would be helpful.

The death toll in South African is also a great concern. The average life
expectancy in the worst affected sub-Saharan countries has fallen by 20 years.
The biggest increase in deaths among 20-49 year old adults accounts for 60 % of all
deaths in sub-Saharan Africa. Perhaps an historical snapshot of the life expectancy
of both men and women would be statistically helpful in analyzing the historical
trend of life expectancy in these regions. Also, the case study refers to the increase
in deaths, but does not mention the average (mean) or median age of death. This
would provide a clearer picture on the impact that the epidemic is having on the
population. Where does that 60 % fall within that age range?

More quantitative data in the area of economics should be provided. Although
the case study states that increased ARV coverage by 50 % would reduce the
negative effect on the economy by 17 %, AVERT does not mention the specific
positive economic outcome as a result of ARV coverage. The study lacks statistical
research in this area. As with life expectancy, some historical trend data should be
provided as it relates to the impact of AIDS on the economy.

There is some key data that is missing from this case study, which may prevent
potential donors from making a final and informed decision on whether to donate
funds towards this charity. http://www.avert.org/aids-young-people.htm.


http://www.avert.org/aids-young-people.htm

Chapter 2
Introduction to Excel and Basic Charts

Key Concepts

Area charts, Bar and Column charts, Bubble charts, Filtering, Formatting, Line
charts, Pie charts, Pivot Tables, Sorting, Radar charts.

Discussion

In this chapter the key concepts are all about commands in Excel. The first step is to
load the Data Analysis Toolpak. The standard data structure used throughout this
book consists of rows of observations and columns of variables. Some of the basic
functionality will be introduced to familiarize you in navigating through Excel
spreadsheets.

In this chapter the emphasis is on the basic Excel procedures to allow you to
successfully analyze and chart you data. These basic procedures will form the
framework for future chapters that have more complicated Excel functionalities.
The instructions are provided in a detailed step-by-step process so make sure you do
not skip steps. One of the most common frustrations is Excel refusing to compute or
complete your graph and usually it is because a vital step has been ignored by
the user.

There are many versions of Excel for various types of computers under various
operating systems. This book has been compiled using Excel 2010 running under
the Microsoft® Windows operating system. However the instructions and flow
remain very similar regardless of the Excel version you may be using.

These Excel functions and charts will provide a useful companion to your
business applications in the workplace or to your business statistics textbook
applications in the classroom.

L. Herkenhoff and J. Fogli, Applied Statistics for Business and Management 11
using Microsoft Excel, DOI 10.1007/978-1-4614-8423-3_2,
© Springer Science+Business Media New York 2013
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Basic Concepts

Start Up

> Click on the Start button in the lower left corner of your Windows desktop.
The Windows Start menu will open

> Click on All Programs and the Programs menu will appear to the right of the
Windows Start menu

> Open the Microsoft Office folder and select Microsoft Excel 2010 (or whatever
version you are using)

Windows Media Player
@ Windows Update
=D winZip
< XPS Viewer
| Accessories Documents
. Games
. Google Chrome Pictures
J. Maintenance .
. Microsoft Keyboard Ll
1. Microsoft Office
Microsoft Access 2010 Computer
| [X] Microsoft Excel 2010 1
(1] Microsoft InfoPath Designer 2010 L
@ Microsoft InfoPath Filler 2010
[E Microsoft OneNote 2010
|0] Microsoft Outlook 2010
[B] Microsoft PowerPoint 2010
(B] Microsoft Publisher 2010 Fleko and St
@ Microsoft SharePoint Workspace 201
(W] Microsoft Word 2010
1. Microsoft Office 2010 Tools
1. Microsoft Office Tools

Devices and Printers

Default Programs

1  Back

| Search programs and files pel |
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Adding Data Analysis Toolpak

> Click the File tab on the upper left hand of the Excel window
> Select Options near the bottom of the command menu

Home Insert Page Layout Formuli
|l save ’
Information :
k;’_ Save As
» | Save as Adobe PDF Pe
o m An
5 open E;
=~ Protect
s Workbook ~
Recent = Pr
@ Be
New Check for
lssues =
Print
Save & Send Ve
| o
Help
Manage
I | _] Options . Versions ~
£ Exit

> Select Add-Ins on the left hand side

13
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-
Excel Options
General E
Formulas
Proofing Add-i
Save Na
Act
Language
=g Acr
Advanced
Ina
Customize Ribbon Ani
Ani
Quick Access Toolbar Cus
Dat
cu
Fin
Trust Center He:
Hid
Hid
Invi
Mir

> Select Excel Add-ins, under “Manage:”

Manage: Excel Add-ins E]

> Click Go...
> Check Analysis ToolPak
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Add-Ins Note: Even though there are two (2)
Add-Ins available: Alllaltystf1 Tof:)l]:aks, yo;l{ only r}leled t(i
= select the first one. You will no
H| Analysis ToolPak z | oK | . .
)
["| Analysis ToolPak - VBA need to install the Analysis ToolPak
[T Euro Currency Tools - VBA because that ToolPak uses a
[ Solver Add-in e programing language called Visual
Basic, which will not be covered in
Browse... .
this book.
Automation
Analysis ToolPak
Provides data analysis tools for statistical and
engineering analysis

> Click OK

Once the Analysis ToolPak is installed, it will launch automatically upon opening

Excel

<& Sometimes the Add-in may seem to vanish. This tool is available to you to
re-load as necessary each time you launch Excel.

Excel Elements

Element Purpose

Title bar Displays the name of the application and the current Excel document
Menu bar Contains Excel menus with commands for Excel tasks

Toolbar Contains buttons that allow one click access to Excel commands and features
Formula bar Displays the formula or value entered into the currently selected cell
Worksheet Displays the contents of a chart or Excel spreadsheet results

Cells Stores individual text or numeric entries

Column headings Organizes cells into lettered columns

Row headings Organizes cells into numeric rows

Scroll bar Used to view cell entries that lie outside the main Excel window

Name box Displays the names or references of the currently selected object or cell
Task pane Displays commonly used commands

Sheet tabs Click to display individual worksheets
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Entering Formulas

> Click inside the formula bar
> Type in an “=" sign and type in your formula or click on the fx symbol to
choose from the drop down menu

<& To make the formula easier to use make sure you input the cell location
where your variable is located not the actual value of the variable.

When you input an Excel function the following symbols can be used:

Operator Description

+ Addition

- Subtraction

/ Division

* Multiplication
A Exponentiation

Cell References

» For a list of data values, use a colon. If you copy and paste a formula in a row or
column, the cell reference in the new formulas will shift along with the cell.
In this example we are asking Excel to sum up all of the data from cell A2 to
cell All

Example: SUM(A2:A11)

] Bookl

2] 8 [ c
1 |groups

2 1

3 5

4 3

5 7

6 6

7 8

8 4

9 9

10 2

11| 7

12 |=SUM(A2:A11)

13 | [ SUM(numberl, [number2], ..) }
14




Discussion 17

» For a fixed reference, use dollar signs. If you copied this formula into other cells,
it would still point to cells A2:A11 and would not be shifted to reflect a new cell
location. Note Excel will recognize the following formats as being the same:
$AS$2, $A2, A$2

Example SUM($A$2:$A$11)

@JBookI
A B | ¢ | D E
1 |groups
= 1
3 | 5 |=SUM($AS2:SA511}
a 3 I
D 7
6 6
7 8
8 4
9 9
10 2
11 7|
12 52
13

Sorting Data

To sort a column of data:

> C(Click on the Data tab

m Home Insert Page Layout Formulas Data Review View Acrobat

> Highlight the previous data set above or create your own data set

<& If you want to preserve the original data set/order, you need to copy and
paste it in another column; otherwise Excel will replace the unordered
column with the ordered data.

> Choose the Sort function

o (
2 3%
il Sort Filter

¢y advanced
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> Select the type of sorting
> You can sort by more than one level

5ot =)

s | [ Koo | [ Dagorio | = - [rowe] ) ssmrestees
| Coumn SortOn Order ‘
Sortby  Column A [w] vahes [w] Smallest toLargest -
[ ox ][ conce |

Filtering Data

> Highlight the data set above or create your own data set that you want to filter

<& If you want to preserve the original data set, you need to copy and paste it
in another column. Excel will replace the unordered column with the
ordered data.

Bookl xlsx

[ A B
Count

38 LB

1
2
3
4
5
6
7z
8
9

> Select the first row with the data label
> Click on the Data tab

“ Home Insert Page Layout Formulas Data Review View Acrobat
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> Click on Filter function

. " K Clear
Al Alz ? "
Ll Z|A -

> Reapply
Z| Ssort Filter .,
&l 7 Advanced

Sort & Filter

> Click on the drop down arrow on the first cell

@_] Bookl

A B
1 |[Count [~]

A] sort Smallest to Largest
Z| sort Largest to Smallest
Sort by Color >

V.

Number Filters L

é.Search p .

-] (Select All)
15

[ oK ] [ Cancel

You can apply a sorting function or a filter(s).
Examples

Choose all values greater than 30. Excel will list the values 54, 68, 73, 82, and 96.
Choose all values < =75 and > =25. Excel will list the values 28, 54, 68, and 73.
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Getting Excel Help

> Click on the question mark on the far right of the upper toolbar

~@c®

> You can type in the concept or the actual question

Visit Office.com for more help with Excel 2010 -

E‘ao‘rﬁa'é‘ Search help E W

More on Office.com: downloads | images | templates

Getting started with Excel 2010

* Getting started with Excel 2010
A * Use sparklines to show data trends
* Use slicers to filter PivotTable data

= Keyboard shortcuts

* Manage large data sets with the
PowerPivot add-in

Browse Excel 2010 support

* Charts * Getting help
* Customizing * Getting started
* Formulas * Macros

= Function reference = Worksheets

ces all
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Statistical Tools

> C(lick on the Data tab

“ Home Insert Page Layout Formulas Data

> Click in the Data Analysis function
{5 Data Analysis

Analysis

Review

View

21

Acrobat

> Highlight the statistical function you need. If the function is not displayed in the
list box, click on the vertical scroll bar on the right of the box or scroll to it

.
Data Analysis

Analysis Tools

Anova: Two-Factor Without Replication
Correlation

Covariance

Descriptive Statistics

Exponential Smoothing

F-Test Two-Sample for Variances
Fourier Analysis

Histogram

m

i

Moving Averag
Random Number Generation .

Predefined or Built-In Formulas

> Click on the Formulas tab

“ Home Insert Page Layo Formulas Data

Review

View

Acrobat
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> Click on the fx or Insert Function button

me Insert Page Layout Formulas Data Review View Acrobat
Insert | AutoSum Recently Financial Logncal Text Date & Lookup & Math More Name
Function - Used ~ - ~*  Time~ Reference~ &Trig* Functions~ Manager

Function Library

> Click on Statistical from the drop down menu to indicate the category
> Highlight the function you want or type in a description of what you want the
function to do

A ™
Insert Function m

Search for a function:
ETypeabﬁefdesuipﬁmofwhatyouwanttodamdmencidc
s (e ]

Or select a category: .Staﬁsﬁcal. i E

AVEDEV(numberl,number2,...)

Returns the average of the absolute deviations of data points from their mean.
Arguments can be numbers or names, arrays, or references that contain
numbers.

Help on this function [ oK ][ Cancel ]

Formatting Data

> Right click on the cells you wish to format
> Select the Format Cells option
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Paste Spedial...
Insert...
Delete...
Clear Contents
Filter
Sort
d Insert Comment
%' Format Cells...
Define Name...

@ Hyperlink...

Pick From Drop-down List...

> Select Number under Category

Format Cells M
Number | Aignment | Font | Border | Fil | protection |
Category:
General | Sample
Currency
Accounting : N
Date Decimal places: |2 E
Time
Lo [7] use 1000 Separator (,)
Fraction Negative numbers:
Saentific -
Text 1234.10
Special (1234.10)
Custom (1234.10)

formatting for monetary value.

Number is used for general display of numbers. Currency and Accounting offer spedalized

[ox ][ conce

> Choose the correct number of decimal places, usually 2 is sufficient

23
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Chart Wizard

To access the chart wizard:

> Click on the Insert tab

“ Home Insert Page Layout Formulas Data Review View Acrobat

> Select the type of chart you want from the “Charts” section
> You can select any of the following chart types listed. See Fig. 2.1

Name Icon Description

A Shows how data changes over time or between
categories. Values are displayed vertically, categories
Column horizontally .

Column

m( Shows trends in data spaced at equal intervals. Can

Line
also be used to compare values between groups.

Shows the proportional size of items that make up the
whole. The chart is limited to one data series.

Pie

- Shows how data changes over time or between
d’ categories.  Values are displayed horizontally,
Bar categories vertically.

Displays the magnitude of change over time or
~ between categories. You can also display the sum of
group values, showing the relationship of each part to
the whole.

Area

Displays the relationship between numeric values in
several data series. This chart is commonly referred to
as a scatter plot.

Scatter

Other
Charts

Displays a sub-set of charts that are less commonly
used.

Displays stock market data, including opening,

Stock closing, low and high daily values.

Shows the value of a data series in relation to the

Surface L .
combination of the values of two other data series.

Shows the proportional size of items relative to the
whole. It can display more than one data series at a
time.

Doughnut

This is a type of scatterplot but the size of the bubbles

Bubble is proportional to the value of the third data series.

Shows values from different categories radiating from
a center point. Lines connect the values within each
data series.

Radar

Fig. 2.1 Chart types
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Formatting of Graphs

To change graph titles or scales:

> Click on the graph
> Click on the Layout tab (not Page Layout, it should be bracketed off in green
as “Chart Tools”)

2 &l = Bookl - Microsoft Excel | Chart.Tools |

Page Layout Formulas Data Review View Acrobat Design Layout Format

al (¥ A | I | 'J i i__!| -i’-'l _eiu.| 'i_'-.[
ure Shapes Text Chart Axis Legend Data Data Axes Gridlines  Plot

¥ Box Title » Titles ~ ¥ Labels ~ Table ~ > b Area~ 00
Insert Labels Axes Background

> Click on Chart Title function or Data Labels function or other aspects of the
graph you wish to format

Bar and Column Charts

A bar chart or bar graph is a chart with rectangular bars with lengths proportional
to the values that they represent. The bars can be plotted vertically or horizontally.
A vertical bar chart is sometimes called a column chart.

Example Problem

You own a small used car lot and want to do some analysis with car sales and the
days of the week that the cars were sold.

> Enter the text and numbers in columns A and B

. @_]Boukl.xlsx
A | B | ¢

Daysof  #of Cars
the week Sold

1

2 |Mon 10
3 Tues 22
4 |Wed 40
5 |Thurs 12
6 Fri 5
7 |Sat 45

w oo
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> Highlight the 2 columns of data

) Bookl xsx
A ] A ‘ B C

Daysof #ofCars
the week Sold

1

2 |Mon 10
3 |Tues 22
4 |Wed 40,
5 [Thurs 12
6 |Fri 5
7 |Sat 45
8 |Sun 42]
B E

> Select the Insert tab

mme Insert Page Layout Formulas Data Review View

> Select the Column chart function

il X @ =l )

Column Line Pie Bar Area Scatter Other
- - - - Charts ~

Charts M |

# of Cars Sold

‘ - -

50

45
45 ) 42
40
35
30
25 22
20
15 10 12
SERRE
JE Bl BN BN BN I B
Mon Tues Wed Thurs Fri Sat Sun

> Click anywhere on the chart
> Click the Layout tab, under Chart Tools
> Click the Data Labels function to add data labels
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> Click the Axis Titles function to add the appropriate vertical and horizontal
labels

Bookl - Microsoft Excel I

Chart [ools ‘

Data Review View Acrobat Design | Layout Format

Legend Data Data Axes Gridlines Plot Chart Chart 3-D
= Labels * Table * ot Y Area~ Wall~ Floor~ Rotati

[#] Primary Horizontal Axis Title » Axes Background

[i%]  Primary Vertical Axis Title »

# of Cars Sold

%0 45

45 0 42
40

35
30

25

2
20
12
15 10 1
H I
5
0 ] | 1

5
Mon Tues Wed Thurs Fri Sat Sun
Days of the Week

# of Cars Sold

T

Pie Charts

In the pie chart the sum of the percentages on the chart should add to 100 % if you
have used all of the input data correctly. In this example the input data is given as
percent of total sales. In the next chapter you will learn how to calculate the
percentages from the raw data.

Example Problem

As the store manager you wish to complete some sales analysis on each of the
departments in your store. The sales data is “% of total sales” by “department.”

> Enter the text and numbers in columns A and B
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<& Excel will assume the first column is labels so be careful how you enter

the data.
() Bookl xlsx
A I B &
% of
Department Total

Ll Sales

. |Home 15%

~ Bed &Bath 5%
Women's 45%
|Men's 2%
| Children’s 5%
'Shoes 20%
Beauty 3%

1
2
3
4
5
6
7
8
EJewelry & Accessories | S%l
10

> Highlight the 2 columns of data

) Bookl xlsx
4| A [ 8 | ¢
% of
Department Total
1 Sales
2 |Home 15%
3 |Bed & Bath 5%
4 |Women's 45%
5 |[Men's 2%
6 |Children's 5%
7 |Shoes 20%
8 [Beauty 3%
9 [ewelry & Accessories 5%
10

> Select the Insert tab

“ Home Insert Page Layout Formulas Data Review View Acrobat

> Select the Pie chart function

il k@Sl )

Column Line Pie Bar Area Scatter Other
‘ - - - - - - Chartsv

Charts 1
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>
>
>
>

Choose type of pie chart you want
Click anywhere on the chart

Click the Layout tab, under Chart Tools

Click the Data Labels function, to add data labels

ysoft Excel

riew

View Acrobat

Data Axes Gridlines
Table ~ = ~

None

Turn off Data Labels for
selection

Center

Display Data Labels and position
centered on the data point(s)
Inside End

Display Data Labels and position |

inside the end of data point(s)
Inside Base

Display Data Labels and position

inside the base of data point(s)
Outside End

Display Data Labels and position
outside the end of data point(s)

More Data Label Options...

ha ,'f‘”c ols
Design ] Layout I Format

mENOEIC EE =

Chart Chart 3-D
Area' Wall~ Floor ~ Rotation >

Trendl

Background

Children's, 5%

Men's, 2%

Jewelry &

Accessories,

Beauty, 3%

% of Total Sales

5%

Bed & Bath,

29

<& Remember if you want percentages on the chart you need to format the data
cells as percentage. You can select the output as percentages by checking

that box.
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Line Charts and Area Charts

A line chart is a type of chart that displays information as a series of data points
connected by straight line segments. An area chart is based on the line chart. The
area between the axis and the data line are commonly filled in with colors, textures
and hatchings.

Example Problem

You own a small used car lot and want to do some analysis with car sales and the
days of the week that the cars were sold.

> Enter the text and numbers in columns A and B

@Bookl.xlsx
A | B : C
Daysof #ofCars
3 the week Sold
2 Mon 10
3 Tues 22
Wed 40
5 Thurs 12
6 Fri 5
7 _‘Sat 45
8 |Sun I 42'
1}
9

> Highlight the 2 columns of data

@Booﬂ.xlsx
[ a [ 8 | c

Daysof #ofCars
the week Sold

1
2 [Mon 10
3 |Tues 22
4 |Wed 40]
5 |Thurs 12
6 |Fri 5
7 |sat 45
8 [Sun 42
9
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> Select the Insert tab

Me Insert Page Layout Formulas Data Review View

> Select Line or Area function

\\
il @ =l )

Column Line Pie Bar Area Scatter Other
- - - - - - charts -
Charts I

> Select the type of Line or Area chart desired

Line Graph Example

Cars Sold

45
50 0 75

40 [——

y /\ /

. 7\ /

ol N_./
7

Mon Tues Wed Thurs Fri Sat Sun
Days of the Week

# of Cars Sold

Area Chart Example

The area chart just fills in the area below the line.

Cars Sold
50

40

30 1

20 -

# of Cars Sold

10

1

0
Mon Tues Wed Thurs Fri Sat Sun

Days of the Week
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Other Charts

Bubble Chart

A bubble chart plots 3 dimensional data as a 2 dimensional graph using the size of
the bubble to depict the third dimension.

<& You need to have three arrays of data: x, y, size of bubble.

Example Problem

The analysis you wish to complete involves reviewing the product sales and market
share by location. The data that is available to you includes the number of different
products sold in each of your four geographic areas of operation, the sales generated
by those products and the percent of your total market each location represents.

> Enter the text and numbers in columns A, B, and C

@_] Bookl xlsx
A B C D
#of Sales Market
1 |Products Share %
2 14 521,416 15%
3 20 $60,000 23%
4 18 524,400 10%
5 22 $32,000 42%
6

> Highlight the three columns of data

@_] Bookl xlsx
A | 8B | ¢ D
#of sales Market
1 | Products Share %
(B28 14 $21,416 15%
3 20 560,000 23%
Fa 18 $24,400 10%
5 22 532,000 42%
6

> Select the Insert tab

Home Insert Page Layout Faormulas Data Review View
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> Select the Other Charts chart function

N =0 VYRS

Column Line Pie Bar Area Scatter Other

i . b . = v Charts~
Charts =
> Choose a Bubble chart
O =i = 5
Other Line Column Win/Loss | Slicer
Charts =
Stock

M

Ll i

Bubble

“i |\§

] k] &

il AuchartTypes...

> Click anywhere on the chart
> Click the Layout tab, under Chart Tools
> Click the Data Labels function to add data labels

33
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ysoft Excel Chart.Tools

riew View Acrobat Design ‘ Layout I Format

] o) (6] e )

Data Axes Gridlines Plot Chart Chart 3-D Trendl

Table ~ v v Area~ Wall~ Floor~ Rotation v
None Background
Turn off Data Labels for
selection
Center K | E | M
Display Data Labels and position I |

centered on the data point(s)

Inside End

[417| Display Data Labels and position
inside the end of data point(s)
Inside Base L

'_:j | Display Data Labels and position
inside the base of data point(s) |

= Outside End
';J |] Display Data Labels and position
outside the end of data point(s)

More Data Label Options...

$70,000

$60,000 °—

$50,000

$40,000

Sales

$30,000

snao | () 9

$10,000

$0 T T T
12 14 16 18 20 22 24

# of Products

The size of the bubbles is in proportion to the percent of the market share that
each store holds. The bubble chart is included in this book as an example of the
different charts that can be created using Excel; however, this specific chart is
difficult to use and may not have many applications.
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Radar Chart

A radar chart plots multivariate data in the form of a two-dimensional chart of three
or more quantitative variables represented on axes starting from the same point.
It is also known as a spider chart, web chart or star chart. It consists of a sequence
of equi-angular spokes, called radii, with each spoke representing one of the variables.
The length of a spoke is proportional to the size of the variable for the data point
relative to the maximum size of the variable across all data points. A line is drawn
connecting the data values for each spoke. This gives the plot a star-like appearance.

Example Problem
You own a small used car lot and want to do some analysis with car sales and the
day of the week that the car was sold.

> Enter the text and numbers in columns A and B

@_] Bookl xlsx
A | B ] &

Daysof  #ofCars
the week Sold

1

2 [Mon 10
3 |Tues 22
4 |Wed 40
5 |Thurs 12
6 |Fri 5
7 |Sat 45
8 |Sun 42
9

> Select the Insert tab

m Home Insert Page Layout Faormulas Data Review View

> Select the Other Charts chart function

TRV BN )
Column Line Pie Bar Area Scatter Other

- - - v - - Charts -
Charts P

> Choose a Radar chart

> Click anywhere on the chart

> Click the Layout tab, under Chart Tools

> C(Click the Data Labels function, to add data labels
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»soft Excel GChart.1ools

riew View Acrobat Design ‘ Layout l Format

] 2] (o] & (] 0] ) [

Data | Data Axes Gridlines Plot Chart Chart 3-D Trendl

Labels ) Table ¥ s X Area~ Wall~ Floor~ Rotation -
- None Background
"Gl Turn off Data Labels for
selection
Center K L | M

_-j 44| Display Data Labels and position
centered on the data point(s)
Inside End I
<17| Display Data Labels and position
inside the end of data point(s)
Inside Base |
_._] 1| Display Data Labels and position
inside the base of data point(s) |
Outside End

7U[li| Display Data Labels and position
outside the end of data point(s)

=

ore Data Label Options...

# of Cars Sold

The intercepts (the point where the blue line intersects the radial black lines)
in the radar chart indicate how many cars were sold on that specific day of the week.
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PivotTables (Aka Crosstabs)

37

PivotTables (as they are known in Excel) or crosstabs allow you to show how two
different variables are related to each other in a table format.

Example Problem

Your survey company has been asked to collect data on the importance of name
brands to consumers with special attention to the age of the respondents. The
consumers in your sample indicate their importance rating using a scale from 1 to
5, with 5 being the highest possible score and 1 being the lowest possible score.
Input the following sample data you collected:

Age

Importance
of name brands

18-21
18-21
18-21
18-21
18-21
18-21
18-21
18-21
18-21
18-21
18-21
18-21
22-25
22-25
22-25
22-25
22-25
22-25
22-25

N AR LW WN = =)NDWWahsPBRSBSDBRUomu

To insert a pivot table:

> C(Click on the Insert tab

m Home Insert Page Layout

> Select the PivotTable function

Formulas Data Review View Acrobat

%

PivotTable

v
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> Select the appropriate data for Table/Range

\

> Choose where you want the PivotTable report to be placed

> Click OK
> The PivotTable Field List will appear

] Bookl \
(e s | c [ o [\e H
Importance ' ¢
Age STName E Create PivotTable \
¥ Brands E Choose the data that you waNt to analyze
__2_: 18-21 5 E @ Select a table or range
3 i 18-21 5 ' Table/Range:
g 15-21 5 E © Use an external data source
51 1821 5 ! T ]
6, 1821 4 \ 5 :
7 t 1821 a : Connection name:
.8 E 1821 . E Choose where you want the PivotTable report to be placed
] ' @) New Worksheet
9! 18-21 4 ' b=t
10} 1821 3 E - m;:ﬂmr =
11! 18-21 3 : =
12} 18-21 2 H /
13} 1821 1
14} 22-25 1 ]
15} 2225 2 1
16, 22-25 3 H
17} 2225 T
18} 22-25 4 \
19} 2225 a
20 2225 . 2 3
7
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> Click on the PivotTablel box

[ PivotTablel I
To build a report, choose [Flage
fields from the PivotTable [[]importance of Name Brands
Field List
7 Report Fiter 5 Column Labels
1 Row Labels I Values
Defer Layout Update
> Set up your table
Y| B CIDIEIF| G H 1 J K L M N
1
2
|‘ Countof | Column
3| Age Labels . |
Row Grand
AL 12345
5 18-21 11244 12
6 |22-25 12232 7
Grand
Total 23464 19

PGEBRE B L e

4 Row Labels Z Values
Aee v | | countofage v |
[7] Defer Layout Update
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> Click the Values Data or Value Field Settings to edit the table with the
appropriate data

Move Up
Choose fields to add to report: Move Down
Age Move to Beginning
[¥|Importance of Name Brands Miove 16 Eid
¥ Move to Report Filter
i3] Moveto Row Labels
Drag fields between areas below:
7 Report Filter ) Moveto Column Labels
Z Moveto Values
X Remove Field
£ Row Labels @ Value Field Settings...
Age v | | Countof Age X
T —

> C(Click the Show values as tab

Value Field Settings L&ﬁ

Source Name: Age
Custom Name: | Count of Age |

Show Values As

Show values as

No Calculation [z
No Calculation -
D
% of Column Total

% of Row Total

% Of

% of Parent Row Total ] | i

ok [ conce

N
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> Select the appropriate calculation

> Click OK

Value Field Settings M
Source Name: Age
Custom Name: :'Count of'hge
’ Summarize Values By I Show Values As I
Show values as
[ %% of Grand Total E'
Base field: Base item:
Importance of Name Brands
\ 41
|Z|_] Bookl
A B D E F | 6
1 4
2 4
Count of Column
3 Age Labels | .|
' Grand
Row Labe'~, 1 2 3 4 5
4 | v| Total
5 |18-21 5.26% 5.26% 10.53% 21.05% 21.05% 63.16%
6 22-25 5.26% 10.53% 10.53% 10.53% 0.00% 36.84%

jGrand Total

~J

Yy Co

10.53% 15.79% 21.05% 31.58% 21.05%] 100.00%

41

The frequency data for each importance rating value is given within each of the
two defined age categories. It seems that the younger age group contains a larger
sample, 63 % versus 37 %. The younger age group indicated higher ratings in the
4 and 5 categories of importance. This means younger consumer behaviors may be
influenced more by brand names, but we would need much more data to be certain.
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Excel

Common Pitfalls

<& When doing a pivot table, place the variables in the appropriate boxes for Report
Filter, Column Labels, Row Labels, and Values. If you just check the variables,
they will end up in Row Labels and Values by default.

<& Bubble Charts are difficult to use unless you have 3 interconnected variables.
Use caution when deciding to use a bubble chart.

<& Some charts will not display the complete variable labels if the labels are long

and exceed a certain character limit. If you want to create a chart that will fit a

longer variable label, consider using a Column Chart and sizing the graph so that

you can expose more text, or changing the text size.

Don’t forget to include the “=" sign when you input a formula.

Include labels and units for all axes on your charts. By default, Excel will not

label your axes.

& ©

Final Thoughts and Activities

Practice Problems

1. Prepare a pie chart showing annual sales as a proportion of total sales. There are
several options for developing different pie charts from the data.

Region Annual sales ($)
North $18,000
South $52,000
East $26,000
West $30,000

2. Prepare a bar chart to show the number of mistakes made in a year by employees
with different levels of expertise. There are several options for developing
different bar charts from the data.

Expertise level # of mistakes
Novice 36
Apprentice 20
Tradesmen 9

Master tradesman 3
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3. Prepare a line chart to show dollars spent on Valentine’s Day flowers over time.

Year Sale of Valentine’s Day flowers
2011 $15,730
2010 $14,160
2009 $14,750
2008 $17,200
2007 $16,890

Discussion Boards

1. Bubble charts and Radar charts are helpful in displaying data. Why are they not
more common?

2. Pie charts can be a powerful tool for managers to use on a daily basis but can be
easily misused. Explain.

Group Activity

Applied statistical research is an important support activity for the marketing
department. There are consulting companies that provide this type of data. What
types of statistical analysis do these companies advertise on their websites. What
are the challenges in getting managers to accept this data?

Parting Thought

Facts are stubborn things, but statistics are more pliable.

Problem Solutions

1. Prepare a pie chart showing annual sales as a proportion of total sales.

Region Annual sales ($)
North $18,000
South $52,000
East $26,000

West $30,000
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Answer:

West
$30,000

2 Introduction to Excel and Basic Charts

Annual Sales

North
$18,000

South
$52,000

2. Prepare a bar chart to show the number of mistakes made in a year by employees

with different levels of expertise

Expertise level

# of mistakes

Novice 36

Apprentice 20

Tradesmen 9

Master tradesman 3

Answer:
Master Tradesman 3
o
2 9
- Tradesmen
-5
<9
5
5 Apprentice 20
(=7
e
Novice 36
10 20 30 40

# of Mistakes

3. Prepare a line chart to show dollars spent on Valentine’s Day flowers over time.

Year

Sale of Valentine’s Day flowers

2011
2010
2009
2008
2007

$15,730
$14,160
$14,750
$17,200
$16,890
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Answer:

$20,000
$18,000
$16,000
$14,000
$12,000
$10,000
$8,000
$6,000
$4,000
$2,000
$0

Sale of Valentine's Day Flowers

$16.890 $17,200

$15,730

—& 514,750
‘\"\e__

SHT6y_—*

2007 2008 2009
Year

2010

2011

45



Chapter 3
Summarizing Data: Descriptive Statistics
and Histograms

Key Concepts

Central tendency, Dispersion, Histogram, Kurtosis, Mean, Median, Mode, Range,
Sample variance, Skewness, Standard deviation, and Standard error.

Discussion

This chapter examines the analysis tools used for summarizing single-variable
(univariate) data and contains a detailed discussion of histograms. The concepts
of central tendency and dispersion are explored. Excel output associated with the
generation of the histogram provides all of the key descriptive statistics associated
with a univariate data set. These are discussed in detail. The access to Excel
statistical functions is explained with applied examples.

This chapter concludes with an important section on the pitfalls when working
with histograms and the associated basic statistics.

Central Tendency has to do with how the distribution of data clusters around the
middle. We typically refer to this position using three important statistics: mean,
median, or mode.

¢ Mean: The mean of a data set refers to the arithmetic average of all the data
values. To calculate the mean, sum all of the data and divide the sum by the
number of data values.

¢ Median: The median of a data set refers to the value in the middle when the data
values are arranged in ascending order. Half of the values are greater than this
value and half are less than this value. The median may or may not correspond to
a value in your data set; it is just a location.

L. Herkenhoff and J. Fogli, Applied Statistics for Business and Management 47
using Microsoft Excel, DOI 10.1007/978-1-4614-8423-3_3,
© Springer Science+Business Media New York 2013
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¢ Mode: The mode of a data set refers to the value that occurs with the greatest
frequency. If all of the data values occur with the same frequency there will not
be a mode.

Dispersion refers to how spread out the data is as a distribution. We use range and
standard deviation as a means of describing dispersion.

By combining the information about the central tendency and dispersion, you
get a good idea of how the data is distributed even without the aid of graphs.

« Range: The range of a data set refers to the difference between the largest and
smallest data values. The range is the simplest measure of dispersion. The range
can be described by stating the smallest and the largest data values (i.e., $25-$100),
or by stating the actual number of units between these end points (i.e., $75).

« Standard Deviation (6, SD, or sd): The standard deviation refers to the most
commonly used statistic to measure the variation in any data set. This is a group
statistic that summarizes the overall variation of your data. In other words, it
indicates how much your data bounces around the average value. Excel provides
this statistic in the same units as the original values. Figure 3.1 depicts the
concept of standard deviation and provides the formula for a sample.

The concepts of a constant mean and varying spread (dispersion) are shown in
Fig. 3.2. Both distributions have the same center value (the average or mean) but the

Ave +sd
Average
_— > EE— .
Height
Ave —sd
sd = X — %)?
n—1
Fig. 3.1 Standard deviation
Center Center
0 10 20 30 40 0 10 20 30 40
spread spread

Fig. 3.2 Center and spread
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second distribution is more spread out (greater dispersion). The more spread out
a distribution is, the larger the standard deviation and range.

Other less used statistics that are provided in the Excel Data Analysis output
include:

Kurtosis: Kurtosis refers to how peaked a distribution is or conversely how flat it
is. If there are more data values in the tails, than what you expect from a normal
distribution, the kurtosis is positive. Conversely if there are less data values in the
tails, than you would expect in a normal distribution, the kurtosis is negative.

» Excel cannot calculate this statistic unless you have at least four data values.

Positive Normal Negative

Fig. 3.3 Kurtosis

Skewness: Skewness describes the lack of symmetry in the distribution. If the data is
pulled to the right creating a right hand tail, it is a positive skew. Positively skewed
data has a mean greater than the median. Conversely if the data is pulled to the left
creating a left hand tail, it is a negative skew and the mean is less than the median.

<& Excel cannot calculate this if you input less than three data values.

Negative Skew Positive Skew

Fig. 3.4 Skewness

Standard error: This is a measure of the uncertainty about the mean. This becomes
an important statistic when working with inference analysis, which is discussed in
Chap. 7.


http://dx.doi.org/10.1007/978-1-4614-8423-3_7
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Discreet Continuous
individual bins distribution

Fig. 3.5 Histogram

Sample variance: This is just the standard deviation squared.

Symbols

2 = Greek capital letter Sigma which means “take the sum of” or “sum together”
everything that follows the sign

X or p = average, mean

N or n = number of data values in your data set; to be accurate, we use capital N for a
population (all the possible data) and lower case n for a sample (some of the data)

o or SD or sd = standard deviation; to be accurate, we use capital SD or ¢ for the
standard deviation of a population (all possible data), and lower case sd for a
sample (some of the data)

The Histogram

Histograms are used for charting frequency data. These graphs or charts use individ-
ual categories, bins, or classes to count how many times a variable occurs. We can
also think of the histogram as more of a continuous or connected graph. See Fig. 3.5.
We see from Fig. 3.5 that if we use an infinite or unlimited number of narrower
and narrower bins we would eventually approximate a continuous distribution.

Excel

Descriptive Statistics

> Input the following data into Column A cells A1 through A15:7,6,5,4,5,6, 2,
3,4,1,6,9,8,7,2

> From the Data tab, choose the Data Analysis function.

> Select the Descriptive Statistics option, under Analysis Tools

> Click OK
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Data Analysis ™)
Analysis Tools
Anova: Two-Factor Without Replication - E
Correlation
o] e
|Descriptive Statisties |
Exponential Smoothing |}
F-Test Two-Sample for Variances 3
Histogram
Moving Average
Ranclom M .
Bookl
i A B C D | E | F G H 1 ]
1 7 -
23] 6 Descriptive Statistics M
i} L]
3 1} il
| L] III:I.IK
n Ll
4l : it Range: s a0 %
L]
D E 5: Grouped By: @ Columns m
o o
7 A | Labels in first row
8 : el
9 4 Output options
10 E 1,:. © Qutput Range: | $C$1
11 6 ) New Worksheet Ply:
12} 9 ) New Workbook
13} 8} @ .
' 2 |¥] Summary statistics .
"
i: i 2: ("] Confidence Level for Mean: 95 %
% fumsnnen + [7]Kth Largest: 1
| || Kth Smallest: 1
17 | 8 =
18
19|

> Enter the range of data in Input Range:

Input Range: 8as1: sas1s|

> Choose the option that fits your data in Grouped By: [columns or rows]

Grouped By: 9 Columns
Rows

> Select Output Range:
> C(lick inside the text box.

<& Important to do this first or you will create problems in your Input Range.
Then select the output range.
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Output options
@ Qutput Range: SCS1 £
New Worksheet Ply:
*) New Workbook

> Click Summary Statistics

V| Summary statistics

> Confidence Level for the Mean: Excel default is 95 % which should be
acceptable for all of your work. However you can input any value greater
than 0 and less than 100. You can leave this unchecked.

> Kth largest. If you want the third largest value in the data set you input 3. The
default is 1. Values can range from 1 up to the number of data points you have in
the distribution. You can leave this unchecked.

> Kth smallest: If you want the second smallest value in the data set you input
2. The default is 1. Values can range from 1 up to the number of data points you
have in the distribution. You can leave this unchecked.

> Click OK

Descriptive Output Results

E‘]J Bookl

| A | 8 [ ¢ [ o] ¢

1] 7 Column1

2| 6

23 5 Mean 5
4 4 Standard [ 0.601585
LS 5 Median 5
NG| 6 Mode 6
a7l 2 Standard | 2.329929|
8 | 3 Sample Vi 5.428571
L= 4 Kurtosis  -0.75623
10| 1 Skewness -0.11729
| 11| 6 Range 8
12| 9 Minimum 1
13| 8 |Maximum 9
14| 7 Sum 75
15 2 Count 151
16 |




Excel

The most important output value is the Count; this is your check that all of the

data has actually been input and used in the calculations.

But when it is difficult to read the names of the statistics, we need to adjust the

column width.

Changing the Width of the Column Output

Let’s make the column width large enough to show all the words

> Place your cursor on the line at the far right of the top cell in the column you
want to make wider. In this case we want Column C to be wider.

Before:

@Bnnklxlsx

A cll|ID
1 7 Columnl
2 6
3 5 Mean 5
4 4 Standard | 0.601585
5 5 Median 5
6 6 Mode 6
7 2 Standard [ 2.329929
8 3 Sample Vi 5.428571
9 4 Kurtosis  -0.75623
10 1 Skewness -0.11729
11 6 Range 8
12 9 Minimum 1
13 8 Maximum 9
14 7 Sum 75
15 2 Count 15

[y
h
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> Drag this border line to the width you want for the column.

After:
le] Bookl.xlsx
A B c ~ b E
1 7 Columnl1
2 6
3 2 Mean 9
4 4 Standard Error 0.601585
5 5 Median 5
6 6 Mode 6
7 2 Standard Deviation 2.329929
8 3 Sample Variance 5.428571
9 4 Kurtosis -0.75623
10 1 Skewness -0.11729
11 ] Range 8
12 9 Minimum 1
13 8 Maximum 9
14 7 Sum 75
15 2 Count 15
16
OR:

> Right click the top cell of the column you want to make wider. Select Column
Width. You can make the column as wide as you need.

Calibri

B \ F G
o b
Ea copy

Mean (4 Paste Options:
Standal =)
Mediar Paste Special...
Mode Insert
Standal i
Sample Delete
Kurtosi Clear Contents
Skewn( (37" Eormat Cells...
Range Column Width...
Minimu Hide

Maximi Unhide
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> Type in the desired column width in the popup box.

B C D E F G
Colugnni

{Mean 5

Standard § 0.601585

Median 3

Mode Column Width \M
Standard § 2 =

Sample V Column width: | 20

|Kurtosis | - I oK J [ Cancel l
Skewnesq -

Range

Minimum)| 1

Maximun)

Sum 75

Count 15

You can also auto format the column width by double clicking the line on the
right side of the column label, which is above the first cell, of the column you want
to make wider.

Using Excel Functions

We can also calculate the descriptive statistics one by one using the separate
functions in Excel.

> C(lick the fx symbol in the white function bar

Insert Page Layout Formulas Data Review View

= Cut PR P — 1
sc Calibri *11 ~ A" A = o 'I - 5

Past A Copy. = | & A - ; .
aste - | hd - - = == i= 5= E
- .fFarmat Painter 41U £ === FFE -
Clipboard ] Font . Alignment

ca v~ AL
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> Input the description of what you want to do, if you do not know the name of the

statistical function, OR click on the next box and select Statistical, if you do
know the name of the function

> Select the function you nee

”

Insert Function \ [ 2 [ )
Search for a function:

[ Type 2 brief description of whak you want to do and then dick
E

Or select a category: 'Statistical B
Select a function:

AVERAGE | _I
AVERAGEA

AVERAGEIF

AVERAGEIFS

BETA.DIST

BETA.INV

AVEDEV(numberl,number2,...)

Returns the average of the absolute deviations of data points from their mean.
Arguments can be numbers or names, arrays, or references that contain
numbers.

Help on this function

ok || cancel

> Click OK
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Statistic Function name Calculates
Mean AVERAGE Arithmetic average of the data set
QUARTILE
Median QUARTILE.INC Median of the data set
QUARTILE.EXC (You need to
input 2 for the quartile value)
MODE
Mode MODE.MULT Mode of the data set
MODE.SNGL
STDEV
STDEV.P Standard deviation of the data
Standard Deviation STDEV.S set (both population standard deviation
STDEVA and sample standard deviation)
STDEVPA
STDEVP
Range xg{ Range of the variables
Count COUNT Total count
Skewness SKEW Calculates how skewed the data is
Kurtosis KURT Calculates the kurtosis of the data
Kith largest LARGE Displays the “K” largest number in
your data set
Kth smallest SMALL Displays the “K” smallest number in

your data set

Fig. 3.6 Functions

Be careful to choose the exact function as listed in Fig. 3.6. Excel has many
functions that are only different by one letter and each of those functions will
deliver a different result.

Histograms

Excel provides a table with the frequency data as well as the actual histogram graph.
Remember a histogram does not have spaces between the bars because both the
x and y axes are scales and show quantitative data.
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Example Problem

You have collected some proficiency scores for the administrative assistants in your
department. The proficiency scale ranges from O to 1,000, with 0 being the lowest
possible score and 1,000 being the highest possible score. You decide that the best
way to get a sense of the data is to graph the data in a histogram. Here are the steps
you would need to take.

Input the following data in column B

Data
99
150
300
780
350
500
510
360
200
175
196
450

Setting Up the Bin Ranges

Before you create the histogram you need to identify your bin/category/class
ranges. As a guiding principle, charts have somewhere between 5 and 15 bins.
Too few bins or too many bins confuse the story.

Arbitrarily choose a certain number of bins. Let’s choose seven bins. To get the
width of those bins determine the range of the data and divide by the number of bins
you want. In this example the range goes from $99 to $780 (Fig. 3.7).

7 bins
Range $99-$780
Bin width = ($780—$99)/7 = $97.28

Because using bin widths of $97.28 would be confusing, we can round up or
down to choose an easier bin width, such as $100.

In a new column, type in the largest number in each of the bins to indicate the
end point of each bin. In Fig. 3.7 all of the data < 100 will be reported in that first
bin. All of the data greater than 100 and < 200 will be reported in that second bin.
Remember these are the end points of the bins you input to Excel.
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] Bookl xsx

7] B [ c | o el e 6 1 4 T T— F—
1 |bin data | 1 Histogram [B2R 5
2 100 99 =

2 = e Input Range: $851:8513 |E E

g = o

Z 400 730 Bin Range: $AS1:5A58 4

5 500 350 @ iobels

7 600 500 )

8 700 510 U options -

9 160 ® Qutput Range: 1 E=]

10 200 () Mew Worksheet Ply:

11 175 (2 New Workbook

12 196 L_ Pareto (sorted histogram)

13 450 [ Cumuiative Percentage

14 [Vlighart Sutput]

15 |

16

Fig. 3.7 Input Bin ranges

Keep track of where you have entered your bin ranges as you will need this as an
input field for the histogram.

Creating the Histogram Chart

Now you are ready to create a histogram.

> Under the Data tab click on the Data Analysis function on the far right
> Select Histogram from the list of options under Analysis Tools and click OK

> Highlight the Input Range for the data

Input Range: $851:48$13



60 3 Summarizing Data: Descriptive Statistics and Histograms

> Highlight the range of cells where you have typed the end points of the bins

Bin Range:

SAS1:5AS8

> Click on the Output Range: button and then click inside the box. Now
highlight a cell where you want the output to start

@ Qutput Range:

> Check Chart Output or you won’t get a graph

[Vlighart Output

> Click OK

$Ds1

[ e

-~

Histogram

Input

Input Range:
Bin Range:
[¥] Labels

Output options
(@ OQutput Range: $Ds1
() New Worksheet Ply:

() New Workbook

[7] Pareto (sorted histogram)

[7] cumulative Percentage

$B851:8B513

SAS1:SASE

E3
E3

E.3

Histogram Clean Up

The actual histogram needs some cleaning up.
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Closing Gaps Between Bars

> Right Click in any column on the graph

> Click the Format Data Series option from the menu

Select Data...

Add Data Labels
Ad{ Trendline...
|3 Format Data Series...

v A A
6 I s =
> | | -
G4
=2
E‘ 2 Delete
= 0 Reset to Match Style

Change Series Chart Type...

Series "Frequer -

A-D-2-F

M Frequency

61
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> Click on Series Options
> Go to Gap Width. Set to 0 % and click Close

@ Primary Axis
Secondary Axis

\
Format Data Series \ [ s
\
seresOptons | | Series Options
Fill Series Qv
Boetiar Colir Separated O Overlapped
Border Styles 0%
Shadow Gap Width
Glow and Soft Edges No Gap O Large Gap
3D Format 0%
Plot Series On

Change Labels on x-axis

> Change the x-axis values from upper limits of the bins to midpoints of the bins
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> Create the column of midpoint labels you want added to your graph

<& NOTE: The data labels\on the x-axis indicate the upper limits of the bins.
In order, to change this tq§ the midpoints, first you need to create a column of
data with the mid-points &f the bins.

@_] Bookl xlsx \
. A |5 c D

1 bin midpoint data

2 | 100 50 93

3 | 200 150 150

4 | 300 250 300

5 | 400 350 780

6 | 500 450 350

7 | 600 550 500

8 | 700 650 510

9| 360 '
10 | 200

11 | 175

12| 196

13 | 450

1A

> Right click on any column on the graph
> Choose the Select Data option
Histogram
6 - = A A" Series "Frequer - |
o Delete incy

9 & J Reset to Match Style
S S S g bt

E} Select Data...

Change Series Chart Type...

Add Data Labels
Add Trendline...
#f' Format Data Series...
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> Under Horizontal Axis Labels click the Edit option

Select Data Source m1

Chart data range: -
(oo ] =)

Legend Entries (Series) o Horizontal (Category) Axis Labels

| Hes || Fear |[Xpemove |~ |~ || Fear |

Frequency 100 -

g288

(o J[ concel ]

> Click inside the Axis label range box. Highlight the new column of midpoint
labels

\
] Bookl adsx \
| A B c D E F | 6 H | 1 K L P
1 bin .Tiq:_aclig_l‘dala bin Frequency -
2 100} 50, 99 100 1 Histogram
3 200} 150} 150 200 4
Al 300} 250, 300 300 1 s 6
5| a0l 3s0 780 400 2 | % .4
s mi mi = kaus\,abels # I
7 6004 5500 so0 | Y Lﬁ I -
8 700} 650} 510 | Axis label range: .
9 T 360 |=Sheet2! $582: £5¢] 3 50 350 450 S50 650
10 20 I Price (5)
1 175
12| 196
13 450
14

> Click OK



Excel 65

Removing More from the Chart and Labeling the Last Column

The word More may appear on your graph.

bin  Frequency
100
200
300
400

M mFrequency

288

(== R

More

Fig. 3.8 End-point Bin values

Histogram

Frequency

S DA

50 150 250 350 450 550 650
bin

Fig. 3.9 Mid point Bin values

The last column may not be assigned a numeric label. This is because there

are data values greater than the last bin value you originally input. In Fig. 3.8

———the last bin end value originally selected was 700. In Fig. 3.9 this was changed

to a mid-point bin value of 650. But as you can see from the data there is one value

greater than 700. Excel automatically names this last bin More and will not assign a
numeric label for it on the x-axis.




66 3 Summarizing Data: Descriptive Statistics and Histograms

You can go back and add more bins to ensure all of your data is being included
on your graph with the proper labels. In this case we added 750.

@i] Bookl adsx
| A B c D e Fooo«

1 |bin midpoint data bin Frequency
2 100 50 99 100 1
3 200 150 150 200 4
4| 300 300 1
5 D 400 2
6 350 500 2
7 500 600 1
8 510 700 0
(9] 360 More 1
10 200

11 175

12 196

13 450

14

15 Histogram

16

17| 8 °

18 E 4 -

19

20 g e M Frequency
2 50 150 250 350 450 550 650 750

23 Price ($)

24

Once you have added the extra bins, edit the bin values which will remove the
word “More” from the graph.

Histogram

= Frequency

# of Malfunctions
S = N W B W

50 150 250 350 450 550 650 750
Price ($)

& Changing the bin values will only change the labels on your x axis. The
frequency will still count the data using the initial points you entered, not the
midpoints.
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Remove Legend

67

> Right click on the legend and click the Delete option

Histogram

o

S

# of Malfunctions
o (¥

S0 150 250 350 450 550 650 750
Price ($)

Axes Labels

gary

Calibri(E~ 10 =~ A" A" Legend -

B 7

e >

I

A-B-2-9

Delete
Reset to Match Style

Font...

Change Chart Type...
Select Data...

Format Legend...

> To change the axes labels click the frequency label (y) or bin label (x) and type

the appropriate titles

Histogram

S = N Wk W

# of Malfunctions

50 150 250

450

550 650 750
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Moving Axes Labels

Left click on the axis you want to move; drag and drop

Before

Histogram

# of Malfunctions
S = N W B~ W

50 150 250 350 450 550 650 750
Price ($)

After
g5
2
2 4
23
=
E 2
) 1
3# 0
50 150 250 350 450 550 &50 750
Price ($)
Changing the Bar Color

Right click on any column. Choose the Format Data Series option

# of Malfunctions

Histogram
° 5 “ A A Series 1 «||
¢ BIEEEA-O-RZ-F |
Delete . ,
’ SO 150 250 350 & Resetto Match Style |
Price ($) .;? Change Series Chart Type... I‘
- | g Select Data... |
— |

Add Data Labels
Add Trendline... L
% Format Data Series... i
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Select Fill.

69

> Change from Automatic to the fill you prefer for the bins; if you click on Solid Fill
you can choose from a variety of solid colors by clicking on the color
> Click Close, when you are finished

Format Data Series M
Series Options Fi"
Fill ) Mofil
Border Color © solid fil
e ) Gradient fil
Borcer Styles ) Picture or texture fil
Shadow () Pattern fill
Glow and SoftEdges | | @ Automatic
[T] Invert if negative
3-D Format

[ vary colors by point
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Changing Chart Title

3 Summarizing Data: Descriptive Statistics and Histograms

> Right click on the chart title. Select the Edit Text option; you can retype the
title as you choose but make sure to click outside the text box when done typing

S H I lcalibrie~/18 = A" A" ChartTitle - F
BlrEEsA-&2-2-¢|
Hm‘tugrunrl' —— -
2 6 Delete
% 4 &9 Resetto Match Style
=
ag R Edit Text
A Font.. |
- 3
% o ; |-
50 150 25“ Change Chart Type... 750
[Elj setect Data...
F
@& Eormat Chart Title...

Changing Chart Background Fill

> Right click on the chart background. Click the Format Chart Area option

# of Malunctions

1 | 1 L} ¥ L M
| Calibri (€~ 10 ~ A" A" Chart Area dl: -
BIEEEAS-E-¢
- — g
& & Cut
4 &y Copy
5 Y, Paste Options:
" en =
€ aﬂ Reset to Match Style D S50 650 750
A Font.
|@lp Change ChartType.. |
% Select Data...
(&) Move Chart...
B o -
€3 Bring to Front | » |

Send to Back | »
Assign Macro...

Eormat Chart Area...
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> Select Fill from the left hand menu
> Select the type of fill and color options you desire

Format Chart Area L;m
A | i
Border Color © Nofl
Barder Styles ©) Sokd fil
©) Gradient fil
@ Picture or texture fil
Glow and SoftEdges | | @) pattern fil
3 Format ® Aytomatic
Size
Properties
Alt Text

> Click Close when you are finished

Rotating the y-axis Label from Vertical to Horizontal

> Right click on the y axis label. Click on the Formal} Axis Title option
/

| Calibri (E~10 ~ A" A~ Vertical (Value) ~
Blre=3A-2-2-
Delete

Reset to Match Style

i

Edit Text

# nf s Wunct jone

Font...

Change Chart Type...
Select Data...

@B gl >

Format Axis Title...

== T

o
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Select Alignment from the left hand menu; you can change the alignment and
direction

Format Axis Title [0 o]
s Alignment
Border Color Textlayout
Border Styles Horizontal alignment: | Center Middle IZ|
Shadow Text direction: | Rotate all te... : I
Glow and Soft Edges Custom angle: |
ABC | Horizontal

3-D Format Autofit

Alignment

to =
o e
2 Rotate all text 90

Common Pitfalls

&

Be very careful when calculating the mode. When there is more than one value
with the same frequency (more than one mode) in a data set, Excel will report
the value that appears first in your data set. If each data value appears with the
same frequency Excel will report #N/A.

« {1,1,1,2,2,2,3,3,4} Excel will report that the mode is 1
« {1,2,3,3,3,4,5,6,7} Excel will report that the mode is 3
 {1,2,3,4,5, 6} Excel will report #NA

The formula used in Excel for STDEV.S to calculate the standard deviation uses
a denominator of (n-1), whereas STDEV.P uses the denominator of (N). The
P stands for population and the S stands for sample. When you calculate
the standard deviation by hand you typically use (N) in the denominator of
a population and (n-1) for a sample. These two methods will yield slightly
different answers, so be careful when deciding which formula to use.
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[ R

Label all axes with variable names and units. Excel will not label the axes by
default.

Excel reports the maximum value for each interval as the bin value not the
midpoint.

Excel will include a bin labeled More. Rename the More bin as a numerical
label to avoid confusion.

Excel labels all frequency graphs as histograms. Remember bar graphs can have
spaces between bins. Histograms have no spaces between bins. You need to
close the gaps in the histogram to zero.

Be careful to tell Excel if you are including labels as the first set of cells in the
input. Always check the count (n) to make sure you have all of your data is
included in the Excel calculations.

If you expand your output area Excel will keep repeating the results to fill up the
area. In Fig. 3.10 the data labeled as Column 1 is the same output as Column 2.
There is no need to show duplicate data. You can avoid this by keeping the
output area large enough for just one set of output data. To expand the columns
you need to right click on the top of the column and change the width. If you
simply drag the lowered left corner of the output box you will generate repeated
data.

Fa™

w Column1 Column2 Column3
Mean 5.333333333 Mean 5.333333333 Mean

Standard Error 0.503952631 Standard Error  0.503952631 Standard Error
Median 5 Median 5 Median

Mode 5 Mode 5 Mode

Standard Deviation 1.951800146 Standard Devi 1.951800146 Standard Deviation
Sample Variance 3.80952381 Sample Variar  3.80952381 Sample Variance
Kurtosis -0.464423077 Kurtosis -0.464423077 Kurtosis
Skewness 0.123160466 Skewness 0.123160466 Skewness

Range 7 Range 7 Range
Minimum 2 Minimum 2 Minimum
Maximum 9 Maximum 9 Maximum

Sum 80 Sum 80 Sum

Count 15 Count 15 Count

Fig. 3.10 Output area. Output from dragging the lower right hand corner of the output area

&

Too many decimal places. Excel will calculate as many decimal places as you
indicate in the output format. If no decimal limit is set, Excel will fill the cell and
show nine decimal places. In Fig. 3.11 the input data does not have any decimal
places and yet the Excel output is reported in nine decimal places. This obvi-
ously does not make any sense; Excel is reporting a greater number of significant
figures than we had recorded in the data. You cannot magically create a higher
level of accuracy and precision in your data than exists in the data you are using
for the analysis. The rule of thumb is to allow one more decimal place in the
output than exists in the input data.
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Fig. 3.11 Decimal places
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3 Summarizing Data: Descriptive Statistics and Histograms

F G
Column1
Mean 5.333333333
Standard Error 0.503952631
Median 5
Mode 5
Standard Deviation 1.951800146
Sample Variance 3.80952381
Kurtosis -0.464423077
Skewness 0.123160466
Range 7
Minimum 2
Maximum 9
Sum 80
Count 15

<& If you check Labels in the histogram input window, you need to include a label
in your end point bin data; otherwise, Excel will assume the first bin end point is
a label and will not use this value in the calculations.

(] Bookl xsx

A B TR WY S — H T ——
L ‘l_.:bin data Histogram m
2 100 99 —
2 = N Input Range: |s@sums13 (T
4 300 300
5 400 780 Bin Range: SASLISASE
6 500 350 [¥] Labels
7 600 500 e
: L ::g @ Qutput Range: [sos1 "';@_I
10 200 Z:.- Mew Worksheet Ply:
1n 175 ) New Workbook
12 196 (] Pareto (sorted histogram)
13 450 (] Cumative Percentage
14 [¥F]iGhart Output]
15
6 e ————————————
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<& If you don’t check the Labels box, and you include labels in your input range,
Excel will create a warning message.

g ™
Microsoft Excel LJ—Eh

'0:' Histogram - Input range contains non-numeric data.

Lo ) [ren |

Was this information helpful?

Histogram Checklist.

Do not include a legend unless it is really necessary.

Label both axes with units and variable names.

Make the graph easy to read; clean it up.

If you will be copying the graph in black and white make sure you can still
differentiate data without the color. You can use different patterns rather than
different colors.

Final Thoughts and Activities

Practice Problems

1. The data in the Beverage file represents the amount of fluid in a sample of fifty
2-1 bottles. Using the data from the file, complete the following exercises.

(a) Construct a frequency distribution.
(b) From the output, what is the mean?
(c) From the output, what is the standard deviation?

2. The data in the Electric file represents the cost of electricity in June for a random
sample of fifty one-bedroom apartments in a large city in the southern portion of
the United States. Using the data from the file complete the following exercises.

(a) Construct a frequency distribution.
(b) Construct a histogram.
(c) Around what amount does the monthly electricity cost seem to center?
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Discussion Boards

1. Today no one wants to be considered average but in 1835 the average man was a
symbol of an egalitarian society. According to Quetelet, a French statistician in
the nineteenth century, “If an individual at any given epoch in society possessed
all the qualities of the average man, he would represent all that is good, great or
beautiful.” How would you define the average employee in your current
department?

2. Are TV commercials getting longer, or does it just seem that way? In 1990, 6 %
of commercials were a maximum of 1 min long. Recently, out of a sample of
50 commercials only 16 were 1 min or shorter.

3. Class size Paradox. There are two ways to obtain a mean class size and you need
to choose one for your training department’s report. In one approach you take the
number of employees in all 25 seminars offered this year and average those
results. The second approach is on an employee by employee basis, compile a
list of class sizes for all seminars he or she attended during the year and average
those results. The results for the two approaches will be different. Discuss.

Group Activity

1. The Central Intelligence Agency has specialists who analyze the frequencies of
letters of the alphabet in an attempt to decipher intercepted messages. For
example in Standard English text the letter “r” is used at the rate of 7.7 %.
Choose another letter and using the Internet determine its usage rate. In an
intercepted message sent to Iraq, a page of 2,000 characters is found to have
the letter “f” occurring 42 times. Discuss if this is unusual.

2. What is meant by “Six degrees of separation” and “The Small World Problem?”

3. The Cost of Laughing Index (CLI) is developed using the same approach as is
used to develop the Consumer Price Index. While standard scores and
percentiles allow us to compare different values, they do not take into account
time. Index numbers such as the CLI allow you to compare the current value to a
value at some base time period. Describe the CLI methodology and what it is this
year in the United States.

Parting Thought

Figures don’t lie, but liars can figure.
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Problem Solutions

1. The data in the Beverage file represents the amount of fluid in a sample of fifty
2-1 bottles. Using the data from the file, complete the following exercises.

(a) Construct a frequency distribution.

Bin  Frequency Amount
2.25 1 Mean 2.35672
2.28 1 Standard error 0.006302254
2.31 6 Median 2.36
234 11 Mode 2.368
2.37 15 Standard deviation 0.044563662
240 9 Sample variance 0.00198592
243 5 Kurtosis 0.080400572
More 2 Skewness 0.008832396
Range 0.215
Minimum 2.25
Maximum 2.465
Sum 117.836
Count 50

(b) From the output, what is the mean?

Answer: Mean: 2.36 bottles but we can’t have .36 bottles so just 3 bottles
(c) From the output, what is the standard deviation?

Answer: sd = 0.04 bottles

2. The data in the Electric file represents the cost of electricity in June for a random
sample of fifty one-bedroom apartments in a large city in the southern portion of
the United States. Using the data from the file complete the following exercises.
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(a) Construct a frequency distribution.

Bin  Frequency Utility charge
85 1 Mean 150.06
103.71 3 Standard error 4.481837269
12243 7 Median 151.5
141.14 8 Mode 133
159.86 12 Standard deviation 31.69137525
178.57 10 Sample variance 1004.343265
19729 5 Kurtosis —0.544163238
More 4 Skewness 0.015845641
Range 131
Minimum 85
Maximum 216
Sum 7,503
Count 50

(b) Construct a histogram.

Electricity Cost

—
W

Frequency
S

W

(=)

99 120 140 160 180 200 220
Utility Charge ($)

(c) Around what amount does the monthly electricity cost seem to center
around?

Answer: The majority of utility charges are clustered around $160.



Chapter 4
Normal Distributions

Key Concepts

Chebyshev approximation, Normal distribution, Percentiles, Standard deviation,
Standard units, and z-score.

Discussion

This chapter will discuss one of the most common distributions in the business
world, the “normal curve”. This is another example where the everyday usage of the
word means something quite different from the statistical definition. In statistics
the term “normal” refers to a specific mathematically defined curve that looks bell-
shaped. An entire chapter is dedicated to this topic because of the normal
distribution’s usefulness in many different applications throughout the business
world. The area under the curve is often described as the probability and will be
discussed in more detail in Chap. 8.

As a basis for comparison we provide a brief description of a non-normal
technique for analysis, the Chebyshev approximation.

Normal Distribution: This is a bell-shaped or Gaussian distribution (Fig. 4.1).

L. Herkenhoff and J. Fogli, Applied Statistics for Business and Management 79
using Microsoft Excel, DOI 10.1007/978-1-4614-8423-3_4,
© Springer Science+Business Media New York 2013


http://dx.doi.org/10.1007/978-1-4614-8423-3_8
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Stadpdard Deviation

Mean

%

-3 -2 -1 0 +1 +2 +3

~—

Standard unit scale

Fig. 4.1 Normal curve

The normal distribution is often described as a central region with a left hand tail
and right hand tail. The boundary between the central region and the tails is usually
defined by the particular problem you are trying to solve.

The mean and the standard deviation of the distribution describe the bell curve.

Mean (x): The arithmetic average value of the x variable. This pins down the center
of the bell shape. When using the standard scale unit, the mean is always zero.

Standard Deviation (o, sd, SD): The sd defines the width of the bell shape for a
sample.

where:

2 is the capital Greek letter sigma, which indicates summing up all variables that
follow it. The subscript and superscript indicate you should add the first value
through the “nth” value. Often the short hand version just shows the summing
sign without the sub/superscripts.

x; is the variable you are summing up the values for and the subscript is just a place
holder. So if the subscript was “1”, it means the first value of x.

X is the average or mean value of x

n is the number of values you are summing together, more commonly referred to as
the sample size

Standard (std.) Units: Several features of this distribution are very important.

1. The graph is symmetric about 0. The part of the curve on the left side of O is the
mirror image of the right side of the curve.
2. The total area under the curve is 100 %.
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3. The area under the curve between —1 and +1 std. units is about 68 %.
4. The area under the curve between —2 and +2 std. units is about 95 %.
5. The area under the curve between —3 and +3 std. units is about 99 %.

An individual value is converted to standard units by seeing how many standard
deviations it is above or below the average. Remember the standard deviation is a
group statistic that allows you to convert individual values in the data set to
standard units.

z-score: The z-score or standard score is found by converting a value from its
measured units to standard units. In other words a z-score is the number of standard
deviations a given value of x is above or below the mean. In addition, z-scores
provide the key to using a table of standard normal probabilities to perform
calculations related to normal distributions.

Percentile: The value of a variable, below which a certain percent of observations
fall. For example, the 20th percentile is the value (or score) which indicates that
20 % of the observations are found below (or less than) that value.

20th percentile

-3c -2c -1 M +1o +20 +3C

Chebyshev approximation: This approximation can be used with any distribution.
Not all distributions are normally distributed, or you simply may not know what
the distribution looks like. To err on the side of conservative estimates, it is better
to use the Chebyshev approximation in these cases. Because of its general
application across all distributions, the answers are not as precise. By this, we
mean that the answer you calculate will indicate the MINIMUM amount of data,
in other words it defines the lowest value of how much data you should expect
for your range of interest. So for example, if you want to know how much
data falls between +2 standard deviations in your data set, the solution will
indicate at least 75 % of the data will be located between these values, regardless
of the distribution. For non-normal problems, we use the symbol k for the
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standard deviation. Thanks to Chebyshev, we know that for any non-normal
distribution:

Atleast (1—1/k 2) of the items in any data set will be within £ standard deviations
of the mean, where £ is any value greater than 1.

e At least 75 % of the items must be within kK = 42 standard deviations of
the mean.

e At least 89 % of the items must be within kK = 43 standard deviations of
the mean.

e At least 94 % of the items must be within X = 4+ 4 standard deviations of
the mean.

Excel

When we have normally distributed data, the normal curve allows us to calculate
how much data falls between any two points, and how much data exists in one or
both tails. We can also easily calculate specific percentiles. But remember, we need
to work in standard units. When you have all of the raw data, you can use Excel to
calculate the standard deviation and the mean. However if you don’t have the raw
data you need to be given the mean and the standard deviation to use these
functions.

The functions we will use in this section apply to both cases where you do not
have the raw data and also to those cases where you do have all of the raw data
available in Excel:

* NORMLDIST calculates the probability or distribution of data to the left of your
value and requires the mean and standard deviation statistics. In other words, this
calculates the percentile. The data is input using the following format.

NORM DIST (the x value in measured units, the mean in measured units,
standard deviation in measured units, 1)

The argument 1 (TRUE) tells Excel to compute the normal cumulative
distribution. If the last argument is O (FALSE), Excel returns the actual value
of the normal random variable.

<& The answer is given as a decimal so you will need to multiply by 100 to get
the percentage answer.

« NORM.INV will convert the percentile value to measured units. The data is
input using the following format.

NORM_ INV (the percentile to be converted to measured units and expressed as a
decimal value, the mean in original measured units, standard deviation in
original measured units)
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These Excel functions are summarized by way of examples in Fig. 4.2.
In these examples we assume a dataset which has a normal distribution of
employee ages.

Function NORM.DIST
Input Output Required data
Measured units Percentile units Mean, std dev for data
Example data 45 yrs old 60" percentile (.60)
Function NORML.INV
Input Qutput Required data
percentile Measured units Mean, std dev for data
Example data 87" percentile(.87) 56 years old

Fig. 4.2 Sample input/output

<& Note that other Normal functions exist in Excel (i.e. NORM.S.DIST, NORM.
S.INV) in which all input/output are in standard units. However, normal
distribution analysis can be adequately handled using the NORM.DIST and
NORM.INV functions.

The problem types using these Excel functions include:

1. Percentile Calculation Problems (NORM.DIST) including creating area
graphs

. Converting Percentiles to Measured Units (NORML.INYV)

. Converting Measured units to z-scores (STANDARDIZE)

. Rank and Percentile (RANK, PERCENTILE)

. Non-normal Distributions

|9 I SOV ]

ey

. Percentile Calculation Problems (NORM.DIST)

There are several distribution (area) types that use this function. These include:

(a) Calculating the area to the left of a value
(b) Calculating the area between two values

(c) Calculating the area to the right of a value
(d) Creating a normal distribution or area graph

Example Problem

Your transportation company provides delivery service 7 days a week to stores
selling synthetic fire logs. You need to determine how many trucks and drivers to
have on hand to deliver the product. The data you have collected from last year
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indicate the number of stores requiring deliveries on a daily basis during the months
of December and January. This data seems to follow a normal distribution. The
average number of stores requiring deliveries on any given day during this time is
100. The standard deviation is 15 stores.

Frequency

-3o 20 -1lo i +10 +20 +3o
85 100 115
Stores Stores Stores

Number of Stores Requiring Delivery in December/January

<& Note to answer these questions you don’t actually need a data set as long as you know
the data follows a normal distribution. Very powerful and helpful analysis tool.

(a) Calculating the area to the left of a value

What % of the Time Did You Deliver to Less Than (<) 90 Stores During Last
December and January? In Other Words How Much Data Is in the Left Hand Tail?

/

90 100
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> Click on an empty cell where you want the answer to be output
> Click on the fx button

> Select the Statistical category

Or select a category: | Statistical E

> Highlight the NORML.DIST function from the list or just type in the
NORMLDIST function in the function bar

Insert Function m

Search for a function:

Type a brief description of what you want to do and then dick
o (e ]

Or select a category: | Statistical El

Select a function:

MODE.MULT -
MODE.SNGL

NEGBINOM.DIST

NoRmoOIST _______________________________________m
NORM.INV -
NORM.S.DIST
NORM.S.INV

NORM.DIST(x,mean,standard_dev,cumulative)
Returns the normal distribution for the specified mean and standard deviation.

Help on this function [ OK ] [ Cancel ]

> Click OK

> Insert the value of X in original measured units. This is the upper limit of the
area for which you want to calculate the distribution of data. In other words, this
is the value you want to convert to a percentile

X 90 % = 90

> Insert the Mean value

Note: You must already have
Mean 100 @ = 100 the Mean value.
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> Insert the Standard_dev value

Note: You must already

Standard_dev 15 E - 15 have the Standard_dev
i value.

> Input the value of “1” or the word “TRUE” for normal cumulative calculations
such as this one. Since this is a percentile calculation we select 1 as the last
value in the function input.

Cumulative 3 %] = TRUE

> Click OK

£ . hl
Function Arguments m

NORM.DIST
X |90 90
Mean 100 100
Standard_dev 15 15
Cumulative 1 TRUE
= 0.252492538

Cumulative is a logical value: for the cumulative distribution function, use TRUE; for the
probability density function, use FALSE.

Formula result = 0.252492538

Help on this function [ oK l [ Cancel ]

Based on this data, the answer is given as .252493 which translates to about 25 %
of the time you delivered fire logs to less than 90 stores.



Excel 87

J =NORM.DIST(90,100,15,1)
D E F G

I 0.252493'

Note: The 25" percentile is
90 stores. The shaded area
represents all the stores that fall
below that.

25™ percentile

(b) Calculating the area between 2 values

What % of the Time Did You Deliver Fire Logs to Between 90 and 120 Stores
During Last December and January?

/

90 100 120

> Click on the empty cell where you want the answer
> Type “=" inside the fx box (this prepares Excel to accept a function format)
> Type in the formula NORM.DIST (limit value, mean, sd, 1)
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> Input the upper limit value and the lower limit value of the area where you
want to calculate the data distribution
> Input the mean and standard deviation from your data set inside both sets of

X « Jfc =NORM.DIST(120,100,15,1) - NORM.DIST(90,100,15,1)
C D

brackets as the ne
> Input the value of 1 or the word TRUE for normal cumulative calculations
inside both sets of brackets

X « Jfx| =NORM.DIST(120,100,15,1) - NORM.DIST(90,100,15,1)

C D E F G H 1
=NORM.D

> Click the checkmark to the left of fx

Note: The
formula is
entered

X v Jf« | =NORM.DIST(120,100,15,1) - NORM.DIST(90,100,15,1) “NORM.DIST

(Limit, Mean,

¢ D E F G H ! SD, 0/1)”. Enter

Enter |)' 15, 1) I either 1 for true

or 0 for false.

The answer is given as 0.656296 which translates to during last December and
January you delivered fire logs to between 90 and 120 stores about 66 % of t